
FTP Voyager Scheduler
FTP Voyager Scheduler is a tool for use with FTP Voyager that all allows you to schedule files for 
download, upload, deletion, and folder synchronization.

FTP Voyager must be registered after your evaluation period, if you continue to use it.    Registration 
entitles you to 1 year of support via e-mail and 1 year of free updates and upgrades.    Registration also
bypasses those annoying "nag" dialog boxes.    Click here for more information.
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Registering FTP Voyager
Registration of FTP Voyager is essential to providing you, our customer, with quality inexpensive 
software.    If you use FTP Voyager please register.

To register your copy of FTP Voyager and receive your registration number, press "Purchase" in the 
"Purchase Dialog" or mail your payment, name, address, and e-mail address to:

RhinoSoft.com
P.O. Box 53
Helenville, WI    53137
U.S.A

Current pricing can be found at:
http://www.ftpvoyager.com/pricing.htm

You may also FAX your order to +1 (262) 560-9628.    Use the form found at: 
http://www.ftpvoyager.com/purchase.htm

If you have lost your registration ID, please visit:
http://www.ftpvoyager.com/lostid.htm

RhinoSoft.com can be reached at:
+1 (262) 560-9627 -and- http://www.ftpvoyager.com/sales

Please remember to include your name and e-mail address so we can send your registration ID.    We 
will e-mail your ID within 48 hours.

More information about FTP Voyager can be found at http://www.ftpvoyager.com



Technical Support
Have a question and need more help?    RhinoSoft.com offers a variety of support.    For current product 
support policies, please refer to the FTP Voyager help desk at http://www.ftpvoyager.com/prodsupport

Users who purchased their copy of FTP Voyager from an Official RhinoSoft.com reseller will be referred 
back to the reseller for support.    To receive telephone technical support from RhinoSoft.com, there will
be a mandatory telephone support charge.

If you have lost your registration ID, please visit:
http://www.ftpvoyager.com/lostid.htm

All support options are found at http://www.ftpvoyager.com/prodsupport

Free Email Support

Free technical support is available via email to all users.    RhinoSoft.com asks that all users submit to 
http://www.ftpvoyager.com/support for technical support requests. 

Knowledge Base
Our Knowledge Base is a dynamic support tool that you can use to research solutions to your questions
and problems.    Nearly every technical question posed to our technical support team is answered here.
Visit http://www.ftpvoyager.com/kb to use our Knowledge Base.

Telephone Support for All Users 

Technical Support is available via telephone at a cost; minimum charges may apply.    The Technical 
Support phone number is +1 (262) 560-9627.    Please have credit card information ready.    Free 
support is available via Email.

Sales Issues

Sales questions (of a non-technical nature) relative to FTP Voyager software should be directed to 
http://www.ftpvoyager.com/sales    Sales representatives can also be reached by calling RhinoSoft.com 
at +1 (262) 560-9627.

Technical Support options are subject to change without notice at the discretion of RhinoSoft.com



Contacting RhinoSoft.com
If you have lost your registration ID, please visit:
http://www.ftpvoyager.com/lostid.htm

You may contact RhinoSoft.com by snail-mail at:

RhinoSoft.com
P.O. Box 53
Helenville, WI    53137
U.S.A

Sales: +1 (262) 560-9627
Phone: +1 (262) 560-9627
FAX: +1 (262) 560-9628

For sales inquiries:
http://www.ftpvoyager.com/sales

You may also visit our web site:
http://www.ftpvoyager.com

Click here for information about technical support.



Task, Action, Log, and Transfer Views
FTP Voyager Scheduler consists of 4 "views" or "panes".:

Task (Top Left)
The upper left pane is the Task Pane.    The Task Pane contains a list of tasks to be performed.    To 
create a new task either right mouse click in the pane and select "New", or click in the pane and select 
"Edit | New".    The "Scheduler Task" dialog appears.

Action (Top Right)
The upper right pane is the Action Pane.    The Action Pane contains a list of actions to be performed for
the selected task (selected in the Task Pane).    To create a new action either right mouse click in the 
pane and select "New", or click in the pane and select "Edit | New".    The "Action Dialog" dialog 
appears.

Log (Bottom Right)
The log view shows you what commands and responses are being performed between FTP Voyager 
Scheduler and the connected FTP Server.    The log view also supports pop-up menus.    Simply click in 
the log view with the right mouse button to select options.

Transfer Status (Bottom Right)
The lower right pane is the Transfer Status Pane.    The Transfer Status Pane shows what file transfers 
are currently in progress and the status of the transfer, including the estimated time to completion.



Toolbar
The FTP Voyager Scheduler toolbar allows you to perform many of the common FTP Voyager Scheduler 
commands quickly by pressing a button.

 FTP Voyager
Starts FTP Voyager or if FTP Voyager is already running brings FTP Voyager to the foreground.

 Edit
Edits the selected item.    If working in the Tasks pane, the selected task's edit dialog appears allowing 
you to make changes.    If working in the Actions pane the selected action's edit dialog appears 
allowing you to make changes.

 New
Creates a new item.    If working in the Tasks pane, a new item is created and the Scheduler Task dialog
appears allowing you to create a new task.    If working in the Actions pane, a new item is created and 
the Action dialog appears allowing you to create a new action.

 Delete
Deletes the selected items.    If working in the Tasks pane the selected tasks are deleted.    If working in 
the Actions pane the selected actions are deleted.

 Copy Item
Copies the currently selected tasks or actions depending on pane focus.    If focus is on the Tasks pane, 
the currently selected tasks are copied.    If focus is on the Actions pane, the currently selected actions 
are copied.    This button is disabled by default.    To enable this button, use the Toolbar Options.

 Start
Starts the selected Tasks.

 Start Queued Tasks
Starts all Queued Tasks.

 Cancel All
This Cancel All button allows you to stop running tasks.    This option is useful when a connection is 
"taking too long" or you don't want to perform the operations that are running.

 Start Windows Explorer
This command launches or starts the Windows Explorer.    This option helps you with drag and drop 
operations by easily starting the Explorer.    If, for example, your desktop is covered, you can use this 
option to start the Windows Explorer so that you can easily and quickly transfer files.

 Options
This option allows you to change the FTP Voyager Scheduler options.    This button is disabled by 
default.    To enable this button, use the Toolbar Options.

 Clear Log
This option clears the information from the log pane.    This button is disabled by default.    To enable 
this button, use the Toolbar Options.



 Help Topics
Use this command to display the FTP Voyager Scheduler help topics. 

 Help Overview
Use this command to open the FTP Voyager Scheduler help file and view the "Overview" page.

 Register FTP Voyager
Use this command to enter your registration information into FTP Voyager.    You will enter the 
information sent to you by RhinoSoft.com.    This button is disabled by default.    To enable this button, 
use the Toolbar Options.

 Locate Lost Registration ID
Use this command if you have already purchased FTP Voyager and you have lost your registration ID.    
This button is disabled by default.    To enable this button, use the Toolbar Options.

 Knowledge Base
Use this button to visit the FTP Voyager Knowledge Base on-line.    Our Knowledge Base is a dynamic 
support tool that you can use to research solutions to your questions and problems.    Nearly every 
technical question posed to our technical support team is answered here.    To enable this button, use 
the Toolbar Options.

 Technical Support
Use this button to visit the FTP Voyager Technical Support page.    This page allows you to send your 
questions to our technical support team.    To enable this button, use the Toolbar Options.

 RhinoSoft.com Customer Service Center
This button allows you to maintain your account with RhinoSoft.com.    Here you can modify your 
address, your email address, your name, check for special offers, and updates.    To enable this button, 
use the Toolbar Options.

 Check for FTP Voyager Update
Use this command to check if an update to FTP Voyager exists.    This option starts your Internet 
browser and gives you information about updates.

 Shut Down FTP Voyager Scheduler
Use this command to terminate or close the FTP Voyager Scheduler.    Doing so means that scheduled 
items may not be performed as expected.      This button is disabled by default.    To enable this button, 
use the Toolbar Options.

 Purchase FTP Voyager Electronically
Use this command to purchase FTP Voyager through your Internet connection.    This button is disabled 
by default.    To enable this button, use the Toolbar Options.

 About
Use this command to display the version number of FTP Voyager Scheduler.    If you are using a 
registered version of FTP Voyager, your name will appear in this dialog box.

NOTE:    You may customize the toolbar in two different ways.
1) Use the Toolbar Options in the Options Dialog.    



2) Right mouse click on the toolbar and select "Customize".



Options
The options dialog allows you to setup options of FTP Voyager.    The Options Dialog is divided into 
several pages:

General
These options contain general type options used to configure FTP Voyager Scheduler; the options 
found here include the "Keep Alive" parameters and the ability to specify a viewer.

Connection
These options contain information used to connect to FTP Sites.    The information found here includes 
various time-out values and other connection settings.

Proxy
These options pertain to how FTP Voyager Scheduler is to connect to the Internet or to servers on 
the Internet.    The options here allow you to setup the type of proxy server you're using.

Dial On Demand
These options allow you to select a phone book entry from "Dial Up Networking" so that FTP 
Voyager Scheduler automatically connects and disconnects from the Internet.

User Interface
These options allow you to configure FTP Voyager Scheduler to work the way you want it to work.    It 
allows you to customize and change colors, the look and feel, and even change transfer sounds.

Toolbar
This tab allows you to specify which toolbar options you would like to use.    From this tab you can 
enable and disable each of the toolbar buttons as well as the FTP Site Profile list.

Auto ASCII Extensions
This tab allows you to specify what files extensions are considered to be ASCII text files.    When you 
specify extensions here, files that contain one of these extensions, can be automatically transferred 
using ASCII transfer mode.

Log
This tab allows you to select the log options that you prefer.    These include colors, logging to a file, 
and cache size.



General Options
The following are the General Options available in the Options Dialog:

Run as a system service
Select this option to run FTP Voyager Scheduler as a system service.    When enabled FTP Voyager 
Scheduler will be started prior to user login.

Monitor Clipboard for FTP URL
Select this option to monitor the Windows clipboard for FTP URLs in the form of 
"ftp://ftp.site.com/dir1/dir2/".    When FTP Voyager Scheduler recognizes a URL change on the clipboard,
it attempts to connect to the site URL it found on the clipboard.    FTP Voyager Scheduler will attempt to
connect only while it is running, and a clipboard URL change occurred after starting.    Most web 
browsers support copying ftp:// shortcuts to the clipboard, by right mouse clicking on the link, then 
selecting "Copy Shortcut".    Click here for more information.

Anonymous Password
When using anonymous connections to FTP servers, you are usually expected to use your e-mail 
address as the password.    This field allows you to specify a password to use for anonymous 
connections.    Using your e-mail address may be important for some servers so it can identify your 
activity.



Connection Options
The following are the Connection Options available in the Options Dialog:

PASV Mode
Check this box to always use PASV mode when connecting to an FTP site, regardless of the site setting. 
If the site bypasses using the proxy, the PASV mode specified for the site is used.

Connection Saver
FTP Voyager normally uses multiple connections or logins for file transfers.    By selecting this option, 
FTP Voyager uses only one connection.    You would enable this option if your FTP Server allows you to 
login only once.    If, while performing file transfers, you get a message that says you're already logged 
in or you login not accepted, enable this feature.

If this option is enabled, FTP Voyager will not allow you to browse a site while uploading or 
downloading.

You may override this selection in the Advanced settings for each site.

Connection Time-out
The time-out value in seconds to use for Internet connection requests.    If a connection request takes 
longer than this time-out, the request is canceled. The default time-out is 61.

Connection Retries
The retry count to use for Internet connection requests. If a connection attempt still fails after the 
specified number of tries, the request is canceled. The default is zero. 

Connection Delay
The number of seconds between each connection attempt.    FTP Voyager will wait the number of 
seconds entered here before attempting to reconnect to a site.

Send Time-out
The time-out value in seconds to use for data Internet send requests. If a data send request takes 
longer than this time-out, the request is canceled. The default time-out is 61.

Send Buffer Size
This value represents the number of bytes that FTP Voyager should attempt to send in one packet to 
the server.    This is an advanced feature of FTP Voyager and should only be changed if required.    The 
default value is 512.

Receive Time-out
The time-out value in seconds to use for data Internet receive requests. If a data receive request takes 
longer than this time-out, the request is canceled. The default time-out is 61.

Receive Buffer Size
This value represents the number of bytes that FTP Voyager should attempt to receive in one packet 
from the server.    This is an advanced feature of FTP Voyager and should only be changed if required.    
The default value is 512.





Proxy Options
The following are the Proxy Connection Options available in the Options Dialog:

Internet Access Type
The Internet Access Type allows you to choose how you want to access the Internet.    The following are

the options:

· Direct Internet Access (default) - access the Internet directly without going through a proxy server.  
Also, use this option to access internal FTP sites, or if you access both the Internet and are required
to go through a proxy, use the Advanced options for your site.

· OPEN Site - use the proxy server specified, sending the "OPEN" command to connect.
· SITE Site - use the proxy server specified, sending the "SITE" command to connect.
· UserID = userid@site - use the proxy server specified, but when connecting to a site, use the proxy

server for the site name and create a user id "userid@site" for the user ID.    For example, if 
connecting through a proxy server to Microsoft, the site used would be your proxy server and the 
user ID, automatically generated by FTP Voyager, would be "anonymous@ftp.microsoft.com".    In 
anonymous mode, the password would be "FTPVoyager@www.rhinosoft.com".    With this mode, 
you may also specify a password for the proxy server (if your proxy server requires a password).

· USER after Logon - use this proxy mode if your server requires you to logon using the "USER" and 
"PASS" commands, followed by logging into your server using UserID = user@site.    The sequence 
of events is: Connect to proxy server, USER ProxyName, PASS ProxyPassword, USER userid@site, 
PASS SitePassword.

· UserID = userid@site:port - is the same as "UserID = userid@site" with the exception that a colon 
and the port setting specified for your site is appended after the site name.

· UserID = userid@site port - is the same as "UserID = userid@site" with the exception that a space 
and the port setting specified for your site is appended after the site name.

· UserID = proxy_userID@site - when selected sends the proxy server User ID followed by @ and the 
destination site.    If a proxy server password is required the "PASS" command is issued followed by 
the proxy server password.    After logging into the proxy server and the external server connection 
is established, a normal login procedure occurs to the site.    An example proxy server that uses this
method is the "Check Point FireWall".

· UserID = userid@site proxy_userID - when selected sends the following sequence to the proxy 
server:

USER user@x.host.name proxyUser
PASS password
ACCT proxyPassword

· HTTP Proxy - use the specified HTTP proxy server.    Normally these run on ports 80 or 8080.    NOTE,
when using this type of proxy server ONLY PASV mode is supported.

· SOCKS4 Proxy - use the specified SOCKS4 proxy server.    You may also enter your user name if 
required.    If a user name is not required, leave it blank.

· SOCKS5 Proxy - use the specified SOCKS5 proxy server.    You may also enter your user name and 
password if required.    If a user name or password is not required, leave it blank.

· SOCKS4A Proxy - use the specified SOCKS4A proxy server.    You may also enter your user name if 
required.    If a user name is not required, leave it blank.    The difference between SOCKS4 and 
SOCKS4A is the ability of the proxy server to resolve domain names.    Microsoft uses SOCKS4A.    
Use this proxy server type if the client machine is unable to resolve domain names to IP addresses.

Proxy Name
If you're using a proxy server, enter your proxy server name here.

Proxy Server User ID



If your proxy server requires a User ID and you're using the "OPEN",    "SITE", or "SOCKS4" proxy 
method, you may specify a User ID for the proxy server.    If you don't want to use one, leave this field 
blank.

Proxy Server Password
If you select the "UserID = userid@site" Internet Access Type, you are allowed to enter a password for 
your proxy server.    If you leave this field blank, no password will be used.

The format used for the FTP site is <proxy name>:<proxy password>.    FTP Voyager automatically 
does this operation for you.

Port Number
Enter the port number you want to use when connecting to a proxy server.      Most proxy server types 
will be using port 21, but SOCKS proxy servers use port 1080, HTTP uses 80 or 8080 or some other 
number.

UserID=user@site Delimiter
If your proxy server is of the type "UserID = userid@site", but expects to see a different character than
'@' (such as '#') enter it here.



Dial On Demand Options
The following are the Dial On Demand (DOD) options.    These options are only available if Windows 
"Dial Up Networking" is installed on your computer.

Automatically Dial
Select this option if you want FTP Voyager to automatically connect when required through Windows 
"Dial Up Networking".      If this option is selected, you must select a phone book entry.

Phone Book Entry to Dial
Select the phone book entry you want to use for dial up networking.    You must have at least one entry 
defined in "Dial Up Networking" in order for this option to show any values.    When changing 
selections, FTP Voyager fills in the remaining fields based on the Windows settings for the entry.

User Name
Enter the user name, if required, for your dial up connection.

Password
Enter the password, if required, for your dial up connection.

Domain
Enter the domain name, if required, for your dial up connection.

Try to connect N times
Enter the number of times you want FTP Voyager to attempt to connect using "Dial Up Networking".    
This value may range from 1 to 1000.    If a connection cannot be established, FTP Voyager try again up
to the number of times entered here.

Call Back Number
An empty value indicates that callback should not be used.    This string is ignored unless the user has 
"Set By Caller" callback permission on the RAS server.    An asterisk indicates that the number stored in 
the phone book should be used for callback. 



User Interface Options
The following are the User Interface options. 

Ask Before Deleting Items
Select this option to force FTP Voyager Scheduler to ask you to confirm a deletion.    Deletion prompting
can be used to ensure you don't delete important information by accident.

Highlight Active Pane
Select this option to highlight the active pane when selected.    By highlighting the active pane you will 
be able to identify the pane you are working in.    Remove this check box if the active pane is not to be 
highlighted.    When highlighted a rectangular border is drawn around the active pane.    This option is 
selected by default.

Active Highlight Color
These options allow you to choose the color to use when highlighting the active pane.    Select the 
system highlight color, a predefined color, or create your own.    The following are the color options.

System Highlight
Select this option to use the Windows Highlight color.    This is the color used by menus to 
highlight the current menu selection as your mouse glides over it.    To change this color change 
your Windows Appearance by right mouse clicking on the desktop, select Properties, then select 
"Appearance".    When selected the color buttons become disabled.

Red, Green, Blue, Purple, Yellow, etc.
Select any of these colors to use these predefined colors.    When selected, the color buttons 
change to reflect the color chosen.

Custom
Select this option to define a different set of colors.    Use the color buttons to pick the colors you 
want to use.

Color Buttons
These buttons allow you to define 4 colors to use when highlighting the active pane.    The 
highlight consists of 2 rectangles.    You may choose the upper left inner and outer colors and the 
lower right inner and outer colors of this rectangle

Show Splash Screen at Startup
Select this option if you want FTP Voyager to show its startup or "splash" screen when starting FTP 
Voyager.    Remove this checkmark and the splash screen is not displayed.

Track Select
For lists, this option moves a "tracker" or changes the color of the selection beneath the mouse when 
the mouse pointer moves over the top of a file or folder.    The item beneath the mouse turns a 
different color.    If you hold the mouse over the selection without clicking on it, the item becomes 
selected.

For Window panes, the active pane is changed to the pane under the cursor.



NOTE: this option is not supported by all versions of Windows 95.    If this option does not work, your 
version of Windows probably does not support this extended capability.    Installing a new version of 
Microsoft Internet Explorer usually enables this option.



Auto ASCII
The file extensions, specified here, tell FTP Voyager which files to consider as being ASCII text files.    
Files ending with the extensions specified here, can cause FTP Voyager to automatically use ASCII 
transfer mode for transferring files. The following are the Auto ASCII Options available in the Options 
Dialog:

File Extension List
File extensions are shown in this list.    Extensions can be selected.    When selected, the remove option 
becomes available.

File Extension Field
You may enter a new file extension in the field above the Add button.    To add an extension, type the 
extension (with or without the period), then press the "Add" button.    The "Add" button remains 
unavailable until at least one character is entered into the field.

Add
Press this button to add a new file extension to the File Extension List.    This button remains 
unavailable until at least one character is entered into the File Extension Field.

Remove
Press this button to remove a file extension from the list.    This button remains unavailable until a File 
Extension is selected in the list.



Toolbar and Menu Options
The toolbar options allow you to choose which toolbar buttons you want to use.    Click on the "Buttons"
button in the dialog to remove, add, or reposition toolbar options.    After selecting the "Buttons" 
button, a dialog appears allowing you to remove items from the right side, and add buttons from the 
left side.    You may also move button positions by selecting move up and move down.

For more information about customizing your toolbar, click here.    For other Toolbar Customization 
methods, click here.

Menu and Toolbar Style
Select one of the following options to change the overall appearance of menus and toolbar in FTP 
Voyager Scheduler.

Windows Default
Menus and toolbars will look like almost all other Windows programs, using the default Windows menus
and toolbars.    This is the most generic setting.

Windows XP
Menus and toolbars will have a more Windows XP look using transparent selection bars and multiple 
colors in menus.    This is the default style used when running the Windows Classic theme.

Windows Default Highlight
Same as Windows Default, except the menu selections become highlighted when the mouse passes 
over the menu bar option.

Icy
Uses menus and toolbars with an "icy" look, one with gradients under each of the options and buttons 
giving the option a 3d effect.

Windows XP / Office 2003
Very much like the Windows XP style, however when running using the Windows XP theme looks very 
much like "Title Bar Color Fill" described below.    When running in Windows Classic theme the menu bar
and toolbars are shaded darker on one side, then progressively lighter on the other.

Title Bar Color Fill
Uses Windows XP style menus with much more color.    The menu bar and toolbars all change to a 
lighter color of the title bar.    This is the default style when running the Windows XP theme.



Log Options
The log options allow you to define how you want FTP commands, responses, and status logged.    The 
following are the options:

Clear Log Between Sessions
If selected, FTP Voyager clears the information in the log window when a new session is started.    If not
selected, FTP Voyager appends to the log even between connections.    Checked is the default.

Colors
The color options allow you to select a color for each of the log item types.    Select the color button 
next to the item color you would like to change.    Select the desired color then press OK.

Log Window Cache
You may specify a cache size for the log pane.    You may specify the maximum number of lines you 
want "saved".    After the maximum number of lines is achieved in the log pane, FTP Voyager reduces 
the number of lines by 10%.

Log File
Enter the file you would like to use to store the log information.    You may select the "Browse" button to
select a file, or simply enter the file name and path in this field.    If no log file is specified (the default), 
FTP Voyager will not log to a file.    However, if the log pane is enabled, FTP Voyager will continue 
showing you the FTP commands and responses.

Log to File (enabled)
Check this box to enable logging to the Log File specified above.    If unchecked or no log file is 
specified, FTP Voyager will not log the FTP commands and responses to a file.

Append Between Sessions
When checked, FTP Voyager appends the log information to the log file even between FTP Voyager 
sessions.    This can cause very large log files over time, so be careful with its use.

Status Only
Use an abbreviated version of the log.    When this option is enabled only status information is shown in
the log.    Commands and responses are not logged or shown.    Errors are logged.

Don't Log Server to Server Transfer Status
Select this option to prevent FTP Voyager from logging the transfer status from Serv-U servers when 
doing server to server transfers.    When the transfer status is logged, more memory, screen space, and
disk space can be used.    The information is very repetitive and may not be useful for a log.    This 
option is enabled by default.

Show Raw Listings
Use this option to log or show the raw directory listings as they are received from the server.    This 
advanced option is useful when debugging a server to determine why a directory listing won't show, or
to view the exact listing as it was returned by the FTP server.



File Menu
The FTP Voyager Scheduler file menu allows you to exit from FTP Voyager Scheduler.    The following 
are the File Menu commands:

Shut Down FTP Voyager Scheduler
Use this option to close or exit FTP Voyager Scheduler.    After exiting FTP Voyager Scheduler no 
scheduled operations will occur.



Edit Menu
The FTP Voyager Scheduler edit menu allows you to perform edit operations for FTP Voyager Scheduler.
The following are the commands supported in the Edit Menu:

Select All
This option selects or highlights all of the files and folders in the current pane.    Use this option when 
you want to select all of the items in a pane.

Invert Selection
This option converts selected items into deselected items, and converts deselected items into selected
items.

Edit
Edits the selected item.    If working in the Tasks pane, the selected task's edit dialog appears allowing 
you to make changes.    If working in the Actions pane the selected action's edit dialog appears 
allowing you to make changes.

New
Creates a new item.    If working in the Tasks pane, a new item is created and the Scheduler Task dialog
appears allowing you to create a new task.    If working in the Actions pane, a new item is created and 
the Action dialog appears allowing you to create a new action.

Delete
Deletes the selected items.    If working in the Tasks pane the selected tasks are deleted.    If working in 
the Actions pane the selected actions are deleted.



View Menu
The FTP Voyager Scheduler view menu allows you to perform visual operations for FTP Voyager 
Scheduler.    The following are the commands supported in the View Menu:

Toolbar
If selected, the toolbar is shown under the menu.    This is selected by default.

Status Bar
If selected, the Status Bar is shown at the bottom of the window.    This is selected by default.

Arrange Icons
Icons can be arranged by the following ways:

· By Name
· By Next Run Time
· By Last Run Time
· By Status
· By Order
· By Action
· By Remote File/Folder
· By Local File/Folder

Icons may also be arranged automatically.    Select this option and the files and folders are sorted 
automatically.

Options
Use this command to view or change the options dialog box.



Tools Menu
The FTP Voyager Scheduler tool menu gives you many miscellaneous functions.    The following are the 
commands supported in the Tools Menu:

Start Selected Tasks
This option starts the selected tasks.

Start Queued Tasks
If there are any queued tasks created by FTP Voyager, this option is available.    Select this option to 
start all queued tasks.

Cancel All Running Tasks
Cancels or stops all running tasks.    This option is useful when a connection is "taking too long" or you 
don't want to perform the operations that are running.

Clear Log
This option clears the Log pane from all information.    The log file is unaffected.

Copy Item
This option copies the currently selected task, tasks, action, or actions.    If the Task Pane has focus the 
currently selected tasks are duplicated.    If the Action Pane has focus the currently selected actions are
duplicated.

FTP Voyager
Starts or shows FTP Voyager.    If a copy of FTP Voyager is already running it is brought to the 
foreground.

Windows Explorer
This command launches or starts the Windows Explorer.    This option helps you with drag and drop 
operations by easily starting the Explorer.    If, for example, your desktop is covered, you can use this 
option to start the Windows Explorer so that you can easily and quickly transfer files.



Help Menu
The FTP Voyager Scheduler help menu allows you to get help for FTP Voyager Scheduler and allows you
to order FTP Voyager.    The following are the commands supported in the Help Menu:

Help Topics
This option allows you to search the help file for topics or information that is contained within the help 
file.

Overview
This option shows you an overview of the help file.    From here you can select topics of interest and 
view documentation about your selection.

Purchase FTP Voyager Electronically
This option allows you to purchase FTP Voyager on-line.    With this option you don't even need to pick 
up your telephone or visit a web page to purchase your copy.

Ordering Information
This option gives you information about how FTP Voyager can be purchased and gives you pricing 
information for FTP Voyager, including quantity discounts.

Register FTP Voyager
This option is used after you get your registration ID.    After you receive your registration ID you enter 
your name, e-mail address, and your ID here.    When you're registered you will not be annoyed by the 
initial "splash" dialog or the nag dialogs asking you to register the product.

In addition you will be notified, via e-mail, of updates.    And you will be able to receive e-mail support 
for up to one year after you purchase.

Locate Lost Registration ID
Select this option if you have purchased FTP Voyager but have lost your registration ID.    You will be 
able to e-mail your registration ID to yourself using this option.

Knowledge Base
Select this option to visit the FTP Voyager Knowledge Base on-line.    Our Knowledge Base is a dynamic 
support tool that you can use to research solutions to your questions and problems.    Nearly every 
technical question posed to our technical support team is answered here.

Technical Support
Select this option to visit the FTP Voyager Technical Support page.    This page allows you to send your 
questions to our technical support team.

RhinoSoft.com Customer Service Center
This option allows you to maintain your account with RhinoSoft.com.    Here you can modify your 
address, your email address, your name, check for special offers, and updates.

Check for FTP Voyager Update
Use this command to check if an update to FTP Voyager exists.    This option starts your Internet 
browser and gives you information about updates.



About FTP Voyager Scheduler
Use this command to display the version number of FTP Voyager.    If you are using a registered version
of FTP Voyager, your name will appear in this dialog box.



Using Drag and Drop
FTP Voyager Scheduler allows you to Drag and Drop files and folders from FTP Voyager and the 
Windows Explorer or Desktop. 

Dragging and Dropping from FTP Voyager
Select the items you want to download in FTP Voyager.    These items can be any combination of files or
folders, single items, or multiple items.    Drop them on the selected task in the FTP Voyager Scheduler. 
If the Site Profile does not match the original profile in FTP Voyager a message is displayed allowing 
you to cancel or accept the drop operation.

Dragging and Dropping from the FTP Voyager local panes or the Windows Explorer
Using the Windows Explorer or FTP Voyager, select the items you want to upload.    These items can be 
any combination of files or folders, single items, or multiple items.    Click on one of the selected items 
and drag the items to FTP Voyager Scheduler.    Release the button.    FTP Voyager Scheduler then 
schedules the files for uploading the items to the FTP site.



Customize Toolbar
Opens the Customize Toolbar dialog box, where you can add, remove, and rearrange buttons on the 
toolbars.    This command is available in the View, Options, Toolbar, then by selecting "Buttons" or by 
right mouse clicking on a "blank" area on the toolbar.

The toolbar contains a set of default buttons.    You can remove buttons for commands that you rarely 
use, add other buttons for commands that you frequently use, and specify the order in which the 
buttons appear on the toolbar.
To restore the default toolbar button settings, choose Reset in the Customize Toolbar dialog box.

Customize Toolbar Dialog Box Options

Available Buttons
Displays the buttons that you can add to the toolbar in the active window.    Buttons that are already on
the toolbar are not included in this list.

Add
Moves the selected button in the Available Buttons list to the Toolbar Buttons list and adds the button 
to the toolbar.    The added button appears above the currently selected button in the Toolbar Buttons 
list and to the left of the corresponding button on the toolbar.

Remove
Moves the selected button in the Toolbar Buttons list to the Available Buttons list and removes the 
button from the toolbar.

Toolbar Buttons
Displays the buttons from top to bottom in the order in which they appear from left to right on the 
toolbar in the active window.

Reset 
Restores the default button settings on the toolbar in the active window.

Move Up
Moves the selected button up one space in the Toolbar Buttons list and to the left one space on the 
toolbar.

Move Down 
Moves the selected button down one space in the Toolbar Buttons list and to the right one space on the
toolbar.



Scheduler Task Settings
The Scheduled Task Settings dialog is broken into two parts:

Task
Enter the task information into this dialog.    It includes "FTP Site Profile", "Name", "Description", and 
other miscellaneous information.

Schedule
Enter the schedule information into this dialog.    From this dialog you decide when you want your task 
scheduled and how often.    This tab is not available for queue tasks.



Scheduler Task
Enter your task information here.    From this dialog you specify the address to schedule.    The following
is the information in this dialog:

FTP Site Profile
Select the site profile you want to use when running this task.    Press the "Select" button to make your 
selection

Name
Enter the name of the task.    For example, if uploading your company web page enter "Upload 
Company Web Page".

Description
Enter a description about the task here.      This optional information can be used to help you organize 
your scheduled tasks.

Enabled
Select this option if you want FTP Voyager Scheduler to run the task at the specified time.    Remove 
the check and FTP Voyager Scheduler will not run the task.

Delete the scheduled task when finished
Select this option if you want the Scheduler to delete the task after starting the download.

Start this task when FTP Voyager Scheduler is started
Select this option if FTP Voyager Scheduler should start the task whenever FTP Voyager Scheduler 
starts running.    For example when the computer is turned on, and FTP Voyager Scheduler is running a 
system service, this task will start.



Scheduler Task Schedule
Enter the task schedule information here.    This dialog allows you to choose how FTP Voyager 
Scheduler should scheduler your task.    The following are the settings:

Schedule Task
This selection allows you to choose how often your task is scheduled.    The value you select here 
affects the schedule setting described below.

The following are the specific schedule settings depending on your "Schedule Task" setting:

Daily
Selecting this option causes the task to be run on a daily basis.    You may specify how many days 
between each time run.

Weekly
Selecting this option causes the task to be run weekly.    The task may be run every N weeks, and 
on specific days of the week.

Monthly
Selecting this option allows you to specify a specific day of the month to run, or a particular week 
during the month.    In addition, you may select which months you want to run the task.    When the 
"Select Months" button is pressed, the "Select Months" dialog appears allowing you to select the 
months the task should run.

Once
Selecting this option causes the task to be run only once.

Advanced
Select this button to bring up the "Advanced Schedule Options" dialog.    Here you can set an End Date 
and Repeat times.

Start Date
Enter the date upon which the task should start.    If the start date is in the past, FTP Voyager Scheduler
will start the task when this dialog box is closed.

At
Enter the time upon which the task should start.    If the start time is in the past, FTP Voyager Scheduler
will start the task when this dialog box is closed.



Advanced Schedule Options
This dialog allows you to specify an end date and number of times to repeat for a scheduled item.    The
following are the options:

End Date
If checked, the task runs no longer than the specified date.    After that time it no longer runs.

Repeat
If checked, allows you to specify how often to repeat the task.    When enabled you may specify to 
repeat every N minutes or hours or until a specified time or duration.



Select Months
This dialog allows you to specify during which months to run a scheduled task.    When checked the 
task is run during that month.    The default is all checked.



Action Dialog
This dialog allows you to select what an action is to do.    An action is a sequential item performed 
when a Scheduler Task is run.

Local and remote paths (file and folder names) can contain variables that can help you to uniquely 
identify file or folder paths.    These variables may be used anywhere within the remote and/or local file
or folder paths.    The following are the variables used when executing an action:

%a - Abbreviated weekday name
%A - Full weekday name
%b - Abbreviated month name
%B - Full month name
%c - Date and time representation appropriate for locale
%d - Day of month as decimal number (01 - 31)
%H - Hour in 24-hour format (00 - 23)
%I - Hour in 12-hour format (01 - 12)
%j - Day of year as decimal number (001 - 366)
%m - Month as decimal number (01 - 12)
%M - Minute as decimal number (00 - 59)
%p - Current locale’s A.M./P.M. indicator for 12-hour clock
%S - Second as decimal number (00 - 59)
%U - Week of year as decimal number, with Sunday as first day of week (00 - 53)
%w - Weekday as decimal number (0 - 6; Sunday is 0)
%W - Week of year as decimal number, with Monday as first day of week (00 - 53)
%x - Date representation for current locale
%X - Time representation for current locale
%y - Year without century, as decimal number (00 - 99)
%Y - Year with century, as decimal number
%z, %Z - Time-zone name or abbreviation; no characters if time zone is unknown
%% - Percent sign

NOTE 1: the variables above are letter case sensitive.    In addition, certain characters such as / and : 
cannot be used as part of the folder name.    Examples are:
C:\BACKUP\%m-%d-%Y %H-%M-%S\
C:\BACKUP\%m-%d-%Y \

NOTE 2: these variables are ignored used with "Run External Program" as outlined below.

Order of Execution
Enter a number here that represents the order in which the action is to run.

Download
Select this option to download files or folders.

Remote File or Folder (source)
Enter the name of the remote (source) file or folder to download.    If using a file name the file 
name may contain wild cards such as "*" and "?".    If the name entered here is a folder the name 
must end with "/".



Local File or Folder (destination)
Enter the name of the local (destination) file or folder to download.    If the name entered here is a 
folder the name must end with "\".

Upload
Select this option to upload files or folders.

Remote File or Folder (destination)
Enter the name of the remote (source) file or folder to upload.    If using a file name the file name 
may contain wild cards such as "*" and "?".    If the name entered here is a folder the name must 
end with "/".

Local File or Folder (source)
Enter the name of the local (destination) file or folder to upload.    If using a file name the file name 
may contain wild cards such as "*" and "?".    If the name entered here is a folder the name must 
end with "\".

Synchronize Remote Folders
Select this option to synchronize the contents of a remote folder with the contents of a local folder. 
This option is very useful for updating web pages.

Remote File or Folder
Enter the name of the remote folder.

Local File or Folder
Enter the name of the local folder

Synchronize Local Folders
Select this option to synchronize the contents of a local folder with the contents of a remote folder. 
This option is very useful for receiving updates from an FTP site.

Remote File or Folder
Enter the name of the remote folder.

Local File or Folder
Enter the name of the local folder

Delete
Select this option to delete remote and/or local files.

Remote File or Folder
Enter the name of the remote file or folder to be deleted.

Local File or Folder
Enter the name of the local file or folder to be deleted.



Run External Program or Batch File
Select this option to run an external program or batch file.    When this action is executed, the FTP 
Voyager Scheduler waits for the task completes before moving on to the next action.    Please note; 
the variables outlined above are not used for this action.

Run this Program or Batch File
Enter the file name and path to the program you would like to run.

Start in this Folder
Enter the path name to the folder in which you would like to start the program or batch file.

Move Down (download then delete source)
Select this option to download files or folders, and then delete the source file after downloading

Remote File or Folder (source)
Enter the name of the remote (source) file or folder to move down.    If using a file name the file 
name may contain wild cards such as "*" and "?".    If the name entered here is a folder the name 
must end with "/".

Local File or Folder (destination)
Enter the name of the local (destination) file or folder to move down.    If the name entered here is 
a folder the name must end with "\".

Move Up (upload then delete source)
Select this option to upload files or folders, and then delete the source file after uploading.

Remote File or Folder (destination)
Enter the name of the remote (source) file or folder to move up.    If using a file name the file name 
may contain wild cards such as "*" and "?".    If the name entered here is a folder the name must 
end with "/".

Local File or Folder (source)
Enter the name of the local (destination) file or folder to move up.    If using a file name the file 
name may contain wild cards such as "*" and "?".    If the name entered here is a folder the name 
must end with "\".



Select FTP Site Profile Dialog
This dialog allows you to select an FTP Site Profile created inside FTP Voyager.    Select the FTP Site 
Profile you want to use for the Scheduled Task.



FTP URL Clipboard Monitoring
FTP Voyager Scheduler monitors the Windows clipboard for FTP URLs in the form of 
"ftp://ftp.site.com/dir1/dir2/file.fid".    If FTP Voyager Scheduler finds a string that starts with ftp:// it 
assumes the string is an FTP URL, then automatically attempts to connect to the site and download the
requested file.

FTP Voyager supports the standard URL format for FTP.    The following is the format:
ftp://[user ID:password@]<host name>[:port]/[path name/][get file name]

where the information with in brackets "[]" is optional.

Most web browsers support copying ftp:// shortcuts to the clipboard, by right mouse clicking on the 
link, then selecting "Copy Shortcut".

If you need to specify a space in the FTP URL format, use "%20", which is the hexadecimal 
representation for a space.    (i.e., ftp://myuserid:my%20password@ftp.mysite.com)

This option may be enabled or disabled.    Click here for more information.






